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About the e-Book




‘Learn Arduino from Scratch’ has come a long way since its inception. We, at RuntimeProjects.com, struggled a great deal to understand and master Arduino and Arduino compatible devices. We believe it should not be like that. Arduino was created to bring electronics and electronic projects closer to people, by making it easy to start your very own hardware projects. Still, learning the basics is always difficult, so we decided to start RuntimeProjects.com, a blog dedicated to all new comers to the Arduino world. Since then, we helped hundreds of beginners using tutorials and projects we built and tested ourselves. We have received numerous praises for our work and this fueled our desire to embark on a new journey; to write an e-book that answers most of the problems faced by beginners and sometimes, even by experienced users like ourselves.



In this e-book you will find tutorials which are targeted to beginners having had absolutely no experience with Arduino or any electronics whatsoever. It starts with all the basics, building block by block until finally you reach a point where you can start building simple projects, like reading from a sensor or displaying text on an LCD. Later, we offer some more challenging projects like our famous Lightning Detector which you will be able to build with only information contained in this e-book. You will also connect to WiFi networks, request data, send data and connect your little gadget to the Internet. Finally we attempt to create an invincible TicTacToe player. Yes Arduino is capable of artificial intelligence as well.



So we welcome you to this amazing world, where software and hardware merge together to create amazing things. Have a good read and happy building.
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Introduction to Arduino Part 1








This section of the book is tutorial based. Tutorials for absolute beginners, in the Arduino world. We at Runtime Projects feel that beginners should not struggle to get started with Arduino. In light of this, we are inviting all our visitors to follow this short course, and if we can help in any way, please use our contact form
 


 
http://runtimeprojects.com/contact-us/

 . We will try our best to answer your questions.



In this course we will go through basic Arduino stuff, simple and easy to follow tutorials with sample code.








What is Arduino?








Arduino is an open source hardware and software project, created with a single aim in mind, to be as simple as possible. Arduino is not the hardware you should be afraid of. It was created for people with no profound knowledge of electronics. Arduino comes in a variety of flavors and sizes. It has its own programming language based on C, with bare functionality. The good thing about the Arduino programming language is that libraries can be created and distributed freely. This facilitates many aspects of your project with added functionality and code (normally very complex) ready to be used. The Arduino is programmed with its own IDE, a simple yet very reliable IDE.








Arduino Boards








Arduino comes in a variety of different boards. These boards offer distinct features for particular projects. These include but not limited to,



●
 
 Arduino UNO
 


 



●
 
 
 Arduino Nano
 


 



●
 
 
 Arduino Micro
 


 



●
 
 
 Arduino Pro Mini
 


 



 These are just what we think are the mostly used boards. For the rest of the course, we will be using the Arduino Uno which by far is the most popular board. It is the most comfortable to work with, mainly because of its size, its USB connector and power connector.








The IDE








I assume you have already installed the IDE, if not, install it now. The IDE can be downloaded from Arduino website
 


 
https://www.arduino.cc/en/Main/Software

 . Follow the installation manual if you like.







I’ll wait ……..







OK. All installed and ready. Grab your Arduino, connect it to the PC via the cable, Windows will start installing the necessary drivers. That done, you can fire the IDE.






[image: Arduino IDE]



Arduino IDE







As you can see, at the bottom right corner of the image, ‘Arduino/Genuino Uno on COM9’. These are the board and port being used. Both need to match your own, and could be different than mine. In order to change the board got to Tools > Board > Select your board. The COM port can be changed from Tools > Port > Select the COM port which the Arduino is connected to.







The following is a quick explanation of the basic IDE functionalities. Starting from the top left corner,



●
 
 the ‘very good’ sign compiles the code.



●
 
 the ‘arrow’ sign compiles and uploads the compiled code to the Arduino board



●
 
 next are New, Open and Save







Now you are ready to program your first Arduino project, btw an Arduino program is often called ‘a sketch’. You may be wondering why the setup() and the loop() functions. These are the main functions that all sketches/programs need to contain. Much like the main() function in C, java or C#.







The setup() is called only once, when the board is started/restarted.



The loop() is repeatedly called whilst the Arduino is running.







Let’s write our very first code. You don’t need to understand everything (all will be explained later on).







//this is the pin we will control



//normally this pin has an onboard LED attached to it



int ledPin = 13;



void setup() {



// put your setup code here, to run once:



//making the pin act as Output, because we will write a value to it



pinMode(13,OUTPUT);



}



void loop() {



// put your main code here, to run repeatedly:



//writing the value HIGH to the ledPin. Switches the LED on



digitalWrite(ledPin,HIGH);



//this will pause the execution for 1 second



delay(1000);



//writing the value HIGH to the ledPin. Switches the LED off



digitalWrite(ledPin,LOW);



//this will pause the execution for 1 second



delay(1000);



}







Copy this code and hit the compile and upload button, the arrow button.



This should switch ON the LED for 1 second then back OFF for 1 second and it keeps on going forever hmm … till you pull the plug. There you have it, your first Arduino working sketch.














Introduction to Arduino Part 2







In this section we will go through the Arduino language. We’ll cover programming basics and introduce some of the libraries provided by Arduino. The Arduino Language is very similar to C. It’s almost the same language but Arduino provides us with several libraries to make things a bit easier. If you have absolutely no knowledge of any programming language I suggest you learn basic C programming. It will become very useful in the future and we cannot cover C programming here!








Basic Stuff








In the first lesson Introduction to Arduino we have introduced a very simple sketch that blinks an LED on and off for a period of 1 second. I hope you had some time to change the values to see what happens.



Now it’s time to explain the code and introduce some interaction with our little LED.







int ledPin = 13;







This line initializes an int variable named ledPin with value 13. This will be used to specify the digital pin on the Arduino board. Normally pin 13 has an LED attached to it, so we should see something somewhere blink.







void setup() {



pinMode(ledPin,OUTPUT);



}







We already mentioned a little about the setup() function, it is required by the Arduino platform. Inside this function we put the code that needs to run first and only once, after the Arduino is restarted.



pinMode is the function to set a pin into OUTPUT or INPUT mode (Note: keywords are all caps). To write to a pin we use the OUTPUT, to read a pin’s value we use INPUT. In this case we need to switch an LED on/off so we will be writing to the pin hence OUTPUT is used.







void loop(){



digitalWrite(ledPin,HIGH);



delay(1000);



digitalWrite(ledPin,LOW);



delay(1000);



}











The loop() function is the main function of the sketch. It basically runs all the time in a continuous manner. When it reaches the bottom, it starts over again. The digitalWrite function takes 2 arguments the first is the pin number, in our case it’s 13, the second argument is the value to be assigned, HIGH or LOW. When setting the pin to HIGH, 5v pass through the pin, when set to low the pin is grounded meaning it will give us a reading of 0v hence when putting the pin to LOW, the LED turns off.







The delay function pauses the execution of the sketch for a number of milliseconds, 1 second = 1000 milliseconds.







That settled, we can dive a little bit deeper into Arduino. We will introduce an internal library which is used to communicate directly to the PC via the USB cable (finally something interesting). The library is called Serial, which basically implements a lot of complex algorithms to communicate over the USB port in a very simple way. In the setup function we need to add







Serial.begin(9600);







This function will initialize the serial communication with a speed of 9600 bits per second, the normal speed used to share text data over serial. In the loop function we need to write something to the PC.







Serial.println("LED is ON");



Serial.println("LED is OFF");







These two lines will send the text “LED is ON” and “LED is OFF” respectively, to the PC. We’ll incorporate this into our original code and it should look something like this







int ledPin = 13;







void setup() {



Serial.begin(9600);



pinMode(ledPin,OUTPUT);



}







void loop(){



digitalWrite(ledPin,HIGH);



Serial.println("LED is ON");



delay(1000);



digitalWrite(ledPin,LOW);



Serial.println("LED is OFF");



delay(1000);



}







Upload the sketch using the upload button (the arrow button). Now we need a Serial client to read the text being sent by the Arduino. The IDE already provides that. On the top right corner there is an icon which resembles a lens. If you click on it, the serial monitor will pop up. As soon as you do, text will start lining up in this manner







LED is ON



LED is OFF



LED is ON







We can send everything via serial. For example we can send integers, bytes, or a byte array. We will go through these in the lessons to come.



From now on you should be able to understand a little Arduino programming. Feel free to explore something on your own. Try not to burn down your Arduino though.














Using the Serial Library








The Serial library is one of the most widely used libraries in Arduino development. The serial communication provides a simple communication interface to the PC or any other device that accepts connections over serial protocol. Throughout this course and some of the projects we post, Serial will be used to output either debug data or factual data. Debug data is when we need to output particular data to know where the execution of the program is at a particular time or to output variable values at different intervals. It can also be used as the main data output of your device, case in point the Lightning Detector (we’ll get to this later), where data is being gathered by the PC using the serial communication.







The aim of this section is to give you the opportunity to learn how to setup the Serial library, how to use it in different situations and explain the common function in serial communication. For an in depth knowledge of how the library works, please visit
 


 
https://www.arduino.cc/en/Reference/Serial

 serial page.








Hardware Serial








Every Arduino board has at least 1 hardware serial (UART). It communicates over RX digital pin 0 and TX digital pin 1. These pins are also connected to the USB port on the device.








Software Serial








Software Serial is another library almost identical to Serial but allows for all digital pins to act as TX and RX. This means that the device can communicate to a PC over pin 0 and 1 and to another device over pin 2 and 3.



In the previous lesson, we already saw how to print some text to the Serial port and read it with the serial monitor provided with the Arduino IDE. Today we are going to write and read data over Serial, interpret it and act accordingly.








Writing to Serial








Something we saw last time was Serial.begin. This initializes the serial listener for any communications. This line needs to go in the setup() function, not mandatory but highly recommended. So our first piece of code today







void setup(){




Serial.begin(9600);




}







The parameter ‘9600’ is the speed at which the data will be sent, currently 9600 kbps. Now we can greet the user by adding some println functions in the setup.







void setup() {




Serial.begin(9600);




Serial.println("Hello, Runtime Projects here");




Serial.println("This is lesson 3");




}







The println function will send the text over to the other end of the serial communication, and appends the new line character ‘\n’. This means that the cursor will move to a new line after printing the text on the serial monitor.



Other uses of println are Serial.println(x) where x can be a byte, integer, float or char, or even char array. Play with this function for a while and see how you might use it to stream your data.








Reading from Serial








Serial communication is needed when you need to instruct your Arduino to perform a task on demand. For example you would like to switch an LED on/off at will, or drive a motor to the left by 10 degrees. The possibilities are endless. In order to do this, we need to make the Arduino listen for messages we send over the serial line. Imagine for simplicity’s sake, we want the LED on when we send ‘H’ and off when we send ‘L’ over the serial. Let’s do this.



char incomingMessage;




int ledPin = 13;




void setup() {




 Serial.begin(9600);




 pinMode(ledPin,OUTPUT);




 Serial.println("Hello, Runtime Projects here");




 Serial.println("This is lesson 3");




}




void loop() {




 if (Serial.available() > 0) {




 incomingMessage = Serial.read();




 if (incomingMessage == 'H') {




 digitalWrite(ledPin,HIGH);




 } else if (incomingMessage == 'L') {




 digitalWrite(ledPin,LOW);




 }




 }




}






Now upload the sketch and go to the serial monitor. You should receive the 2 lines we set in the setup. Then send ‘H’ in the serial monitor and check your LED, send ‘L’ and check it again.







Note, the ‘H’ and the ‘L’ are case sensitive.


















Reading and Writing Pin Values








In previous lessons we used the digitalWrite to write to a pin or more precisely to switch a pin on and off. That is the simplest way of using a pin. In this lesson we will go through reading and writing values to pins, both digital and analog.







So we need to settle somethings straight before we proceed here. Digital pins can only be set as HIGH and LOW. Reading them will also give HIGH and LOW so they are pretty straight forward. Digital pins cannot act as analog at least not in a simple way.



Analog pins can output voltage between 0v and 5v. It is specified from the value given to the analogWrite function. This ranges from 0-255, so in order to set the analog pin to 2.5v one needs to do simple proportion (255/5)*2.5. Reading an analog pin gives the same voltage range but in a different resolution. The values from reading pins range from 0 to 1023. You need to remember these numbers as we write our sketches (you will remember after some mistakes).







On board we have all pins enumerated for us D2-D13 and A0-A5 or more. So it will be easy to identify them. I personally prefer referring to digital pins as 4, 6, 7, etc i.e. as integers. While for analog pins I usually use the arduino convention of A0, A1, A2, etc these are built in constants and are translated directly into integers representing the actual pins.







Enough talking for now let's get our hands a bit dirty. By now you should have noticed that when we need to use a pin we specify its usage in the setup function like pinMode(1,OUTPUT). This instructs the chip on how to prepare the pin for us. This is simple… if you need the pin to output a value set it to OUTPUT, if you need it to read a value set it to INPUT. This works for both digital and analog pins.







Some code to keep in mind.







●
 
 pinMode(1,OUPUT); or pinMode(A1,OUPUT);



●
 
 pinMode(1,INPUT); or pinMode(A1,INPUT);



●
 
 digitalRead(1); gives us HIGH or LOW



●
 
 digitalWrite(val); where val can be HIGH or LOW;



●
 
 analogRead(A1); gives us a value between 0 and 1023



●
 
 analogWrite(A1,val); where val can be set between 0 and 255











A word of warning when using pins. Please note that pins cannot handle high currents, all currents should be limited to under 20mA per pin. This means that you cannot short circuit pins without resistors. Also pay attention to LEDs. Never connect LEDs without a current limiting resistor. Typically on a 5v supply, an LED will require a resistor of 300 ohms or so. Please use the formula V=IR to check your circuit before you switch it on as it might burn your chip.



 














Installing and Using Libraries








Libraries are an essential part in the Arduino world. They are what make Arduino so easy to use. Libraries are written to encapsulate complex functions and expose them as simple function calls to the user. For example to switch a pixel on and off in an LED monitor. This is relatively very complex but, fortunately some folks at Adafruit created a library that enables us to handle an LED monitor with simple functions like, draw lines, text, circles, rectangles, etc… Normally these libraries include a readme file with some explanations about the various functions, and examples of how to use the library.







A list of standard libraries can be found on
 
https://www.arduino.cc/en/Reference/Libraries




These libraries are pre-installed once you download the Arduino IDE. So we can start using them right away, others will need to be downloaded and included into the IDE. We’ll go through these, one step at a time.








Installing Libraries








There are 3 ways to install a library. We’ll cover the 2 most common and most simple to use.







Option 1
 : Open the Arduino IDE



From the menu choose Sketch > Include Library > Manage Libraries
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 Installing Libraries







From here one can choose to install libraries from the many known sources. Most of them (if not all) would have been tested by others and most probably libraries found here will have a certain standard. These libraries can be added locally and ready to be used in your sketches.







Another way of installing libraries and probably the most common is by importing a zip file into the IDE. Most Arduino developers produce awesome libraries and make them available for free on Github or any other source code hosting environment. There libraries can be downloaded as ZIP files which are then imported into the IDE directly, hassle free!!



After finding a suitable library for your project, navigate to its homepage on Github and search for the button ‘Download ZIP’. This will download the whole library as a zip file. Now go to the IDE, navigate to Sketch > Include Library > Add .ZIP Library and choose the zip file you just downloaded. The library will be installed automatically and should be found under the list Sketch > Include Library.







As you might notice, certain libraries are hard to understand from just the Readme file or from the source code. So, almost every library developer creates at least 1 example using the library. These examples will be installed with the library and can be access from the IDE from File > Examples then and choose your library.






















Reading Sensor Data – Temperature TMP36








In this section, we will go through the process of reading sensor data, the TMP36 temperature sensor to be precise. First let’s describe the sensor in more detail. The TMP36 has a linear voltage to temperature output meaning there is no error correction to be calculated from our end, the sensor handles it brilliantly on its own.







The following are some details taken directly from the datasheet:







●
 
 Size:
 TO-92 package (3 leads)



●
 
 Price:
 around and under $1.00



●
 
 Temperature range:
 -40C to 150C



●
 
 Output range:
 0.1V (-40C) to 2.0V (150C)



●
 
 Power:
 2.7V to 5.5V
 , 0.05 mA current







The sensor is accurate up to around 125C, beyond that, increasing error margins are to be expected. It has 3 leads







●
 
 Pin 1 – Vin (+2.7V – +5.5V)



●
 
 Pin 2 – Analog Voltage Output



●
 
 Pin 3 Ground
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 TMP36-pinout







Let's get started with connecting the sensor to our Arduino. Connect Pin 1 to +5V on the Arduino, Pin 3 to Arduino GND and Pin 2 to A0 on your Arduino.







That's all, now how are we going to read temperature through an analog pin? So the sensor will output a voltage of 10mV per centigrade starting at 500mV offset to allow for sub Zero temperatures. Having said that, we know we need to convert the analog reading on the Arduino (0-1023) to mV. Using the below formula we can achieve this with ease.







result in mV = (A0 reading)*(5000/1023)







The 5000 refers to the maximum the Arduino analog pin can read. So when using 3.3V Arduino, like the Pro Mini, replace the 5000 with 3300. Now all that’s left is to convert mV to centigrade.







centigrade = (result in mV – 500)/10



And there you go… the result in centigrade.












Sample Code








int sensor = A0;




void setup() {


 Serial.begin(9600);




}




void loop(){




//reading from the sensor


int reading = analogRead(sensor);




// converting sensor reading to milli volts


float reading_mV = reading * 5.0; //if using 3.3v replace the 5.0 with 3.3


reading_mV /= 1024.0;




// convert mV to temperature


float temp = (reading_mV - 0.5) * 100;


//print the temperature


Serial.println(temp);


delay(1000);




}
 
 










Understanding Interrupts




What are interrupts? Well they interrupt something for sure; precisely they interrupt the main program execution of the CPU. In Arduino we have 2 main functions the setup() and the loop(). Interrupts interrupt code execution in the loop().



But why should we care about interrupts anyway? They are not something to be feared, they make your code cleaner and they work much more efficient than conventional coding. An interrupt listens for an external event and reacts to it immediately. The main program will pause the execution and enters the function attached to the interrupt. At this point, it executes whatever there is in this function, and returns to the main program as if nothing happened. That is the beauty of interrupts.



Let’s make a little comparison, we are going to compare 2 sketches which produce the same result but work in a different way.



const int buttonPin = 2; // push button pin


const int ledPin = 13; // the LED pin






int buttonState = 0; // keeps the state of our button




void setup() {


 pinMode(ledPin, OUTPUT);


 pinMode(buttonPin, INPUT);


}




void loop() {


 // read the button state


 buttonState = digitalRead(buttonPin);




 // check if the pushbutton is pressed.


 // if it is, the buttonState is HIGH:


 if (buttonState == HIGH) {





 digitalWrite(ledPin, HIGH);


 }


 else {





 digitalWrite(ledPin, LOW);


 }


}






In this example we are listening to a push button on pin 2, by reading the digital buttonPin. Then checking the button state with an if statement and turning the led on and off.



Simple, isn’t it? But inefficient, looks ugly and is not real time. Interrupts are real time; as soon as the interrupt is raised the attached function is fired.







Let’s look at the same program written using interrupts.



const int buttonPin = 2; // push button pin


const int ledPin = 13; // the LED pin






volatile int buttonState = 0; // keeps the state of our button




void setup() {




 pinMode(ledPin, OUTPUT);




 pinMode(buttonPin, INPUT);




 //Attach an interrupt to the ISR vector


 attachInterrupt(0, pin_ISR, CHANGE);


}




void loop() {


 //empty


}




void pin_ISR() {


 buttonState = digitalRead(buttonPin);


 digitalWrite(ledPin, buttonState);


}







The AttachInterrupt() function




As you might have already noticed there are some differences from the previous example. Particularly the loop() function, which contains nothing. Everything that was handled by the if statement is now handled inside the pin_ISR(). You might have noticed already, this is the function that is executed when the interrupt is raised.



attachInterrupt(0, pin_ISR, CHANGE);



The attachInterrupt() function attaches the function with the interrupt. The first parameter is an index to identify to which pin the interrupt is attached (in Arduino Uno – 0 means pin 2 and 1 means pin 3). The second parameter is the name of the function to be executed. The third parameter is the mode by which the interrupt is raised. There are 4 + 1 modes which can be used these are:



●
 
 FALLING: fires the interrupt when the pin is on the falling edge



●
 
 RISING: fires the interrupt when the pin is on the rising edge



●
 
 CHANGE: fires on any change in the pin



●
 
 LOW: fires when the pin is low



●
 
 HIGH: (Supported only Due) fires when the pin is high



 




The volatile keyword




You might have noticed that buttonState has another keyword, which is volatile. This keyword indicates that the variable value cannot be predicted. Why? Because interrupts cannot be predicted by the compiler and thus the state of a variable which changes inside a function triggered by an interrupt is also unpredictable. So in this case it is worth adding the volatile keyword.










Plants Monitor Using Arduino & Soil Moisture Sensor








Do you have a plant in the living room which you often forget to water? I know, I know you often forget about it. So before it becomes yellow and dries more than the Sahara desert follow this tutorial and build a little soil monitoring project. The Plants Monitor will help you remember to water your little plant by flashing an LED (you can add a buzzer but that's super annoying).







Parts needed:



●
 
 Arduino
 


 (almost any Arduino will do, I am using Uno)



●
 
 RGB LED
 


 



●
 
 
 2x 330 ohm resistor
 


 



●
 
 
 moisture sensor with regulator
 


 



●
 
 
 some jumper wires
 


 







Background








This circuit works on a very simple principle, which is conductivity of water. As you may already know water is a conductor of electricity which means if we put 2 electrodes in water and apply a voltage to one of them, we should read some voltage on the other electrode. The same goes with soil. Soil has an amount of water which can be measured when a current passes through it. To accomplish this, we need a soil moisture sensor with regulator, and it costs less than $2. This sensor (at least my sensor) will give us a value, from 200 (most wet) to 1005 (most dry) which represents the amount of moisture in the soil.







Pin out:



●
 
 Arduino
 => Moisture Sensor



●
 
 D7
 => VCC



●
 
 GND
 => GND



●
 
 A0
 => A0







Your sensor might have 2 parts or just one. Some manufacturers fuse the ‘fork’ and the controller into one, others don’t. Anyway check your model and see if you manage to find these pins.







Grab your LED attach 1 resistor to the red pin and another to the green (we won’t be using the blue pin). Check if your LED is common anode or cathode. If common anode attach the common to 5v or 3.3v, if common cathode attach it to GND. Now I have a common anode so my code is set to work with common anode. If you have common cathode you need to find the function setLED and modify the values of the analogWrite function from example: ‘
 255-240
 ‘ change it to ‘
 240′.







●
 
 LED Green Pin 6



●
 
 LED RED Pin 5



●
 
 LED Common if anode 5v or 3.3v or if cathode to GND








A word of Warning








The reason I put the VCC pin to the D7 on the arduino is to be able to switch on the sensor only when needed. You should be warned that the sensor will corrode over time, since it will always be in contact with moisture, and moisture will corrode the sensor. If you are familiar with electrolysis and accelerated corrosion you might already know that if you pass current through a metal and another substance like water, a chemical process will take place. I got mine to work for nearly 2 months straight, afterwards the pins corroded to the point of breakage.







The Sketch is well documented and you should be able to follow it easily. Basically I split the range of values into 5 colors from Green to Red. Green means the plant has plenty of water and red means that it’s drier than the desert. You can modify these values to suit your environment, your plant and the soil. You can post questions in the comment section and we will answer it ASAP.
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 Moisture Sensor







Grab the code from this link:
 
Plant Monitor

 upload it to your arduino, build the circuit and put the ‘fork’ in the soil. Now your plant will not go thirsty anymore. Note that you need to change the values to suit your plant. I am not responsible for killing your plant due to water oversose or otherwise.














Arduino Ultrasonic Range Finder – HC-SR04








Now that we have managed to build 2 sketches using simple sensors we should try something more interesting. In this section we present a method of measuring the distance between an Arduino and nearby objects. It is of particular use for automated robots for giving them ‘eyes’ to look out for nearby objects, measure the distances between them, and acting upon that distance. We present the HC-SR04 range finder sensor.







The cheap sensors normally have 2 cylindrical objects resembling a speaker with pins in the middle. Well, one of them is a speaker, the other is a microphone.







The sensor has 4 pins +5v, GND, Trig and Echo. Ignoring the obvious (+5v and the GND), we have the remaining 2 which are used to calculate the distance. The microcontroller pulls the Trig pin to High for 10 microseconds, and then pulled down again. At this point the sensor sends an ultrasonic signal (around 40kHz I believe) from the speaker and waits for an echo. If an echo is picked by the sensor, the Echo pin is pulled down (being previously pulled up by the microcontroller). The time it takes from triggering the signal to the echo is the time taken for sound to travel from the sensor to the object and back.







Knowing the speed of sound, which is roughly 340.29m/s we can calculate the distance traveled by sound in that time, then dividing it by 2 to get the distance from the object.


[image: hc-sr04 ultrasonic range finder]
 Sounds difficult? No problem, a library saves the day and makes everything super easy. Connecting the ultrasonic sensor to Arduino is super easy. The library is called NewPing and can be downloaded from
 


 
http://playground.arduino.cc/Code/NewPing#Download

 . Install the library.







Now, first things first. Wire up your sensor to the Arduino as follows







Arduino
 => UltraSonic Sensor



+5V
 => +5V



GND
 => GND



Echo
 => D11 (or any other pin)



Trigger
 => D12 (or any other pin)







You can use any pins you want for Echo and Trigger. Now open the Arduino IDE and copy the following code. This code is an example found in the NewPing Library. I will explain bits and pieces below.








Source Code








#include <NewPing.h>




#define TRIGGER_PIN 12 // Arduino pin tied to trigger pin on the ultrasonic sensor.


#define ECHO_PIN 11 // Arduino pin tied to echo pin on the ultrasonic sensor.


#define MAX_DISTANCE 200 // Maximum distance we want to ping for (in centimeters). Maximum sensor distance is rated at 400-500cm.




NewPing sonar(TRIGGER_PIN, ECHO_PIN, MAX_DISTANCE); // NewPing setup of pins and maximum distance.




void setup() {


Serial.begin(115200); // Open serial monitor at 115200 baud to see ping results.


}




void loop() {


delay(50); // Wait 50ms between pings (about 20 pings/sec). 29ms should be the shortest delay between pings.


Serial.print("Ping: ");


Serial.print(sonar.ping_cm()); // Send ping, get distance in cm and print result (0 = outside set distance range)


Serial.println("cm");


}






The library makes it very easy to use this sensor as you can see from the code above.



The line ‘#define MAX_DISTANCE 200’ defines the maximum length we can read, in cm. Normally these sensors are rated between 400cm and 500cm, but I personally recommend a maximum of 200 cm or maybe 250cm. In practice I got fairly good results below 250cm but the percentage error increased as it reached 400cm. The line below is initializing a NewPing object named sonar with the pin values and the maximum distance.







NewPing sonar(TRIGGER_PIN, ECHO_PIN, MAX_DISTANCE);







The most important line is the ‘Serial.print(sonar.ping_cm());’, particularly ‘sonar.ping_cm()’. This function will do all the initialization sequence and calculations necessary to get the distance, and returns the length in cm.







If the returned value is ‘0’ then the distance is out of range … in this example, above 200 cm.



Now you are ready to install this sensor on your robot In the meantime, you might want to take a look at another cool albeit advanced functionality of the NewPing library, which is the multi sensor example.







You will find it under NewPing15Sensors, and it shows how the library can be used to monitor 15 ultrasonic range finders at the same time!! Now your robot might need a vision upgrade!!







 














433 Mhz RF Wireless Data Transfer







[image: Transceiver 433mhz]
 Transmitter Receiver – 433 Mhz







The most practical and cool way of sharing data from one Arduino to another is by far using a radio transmitter and receiver. The simplest form of wireless transmission (I could find) is the 433Mhz ASK modules. They come in pairs, a receiver and a transmitter. They are ridiculously cheap, selling at $1 or less a pair!!







These modules provide simplex 1 way data transmission, in order to get a 2 way communication channel is by installing 2 pairs. May I point out that these devices provide no verification of receipt, no CRC checks any form of validation. One needs to take measures into hands to verify successful message transmission, if that’s needed. That aside, they are great for small data transmission over small distances.







It is imperative to add an antenna to the modules. It can be attached near the marking ‘ANT’. The antenna is nothing else than a piece of wire of around 17cm in length. Alternatively, cheap helical antennas for 433Mhz are available for sale like the one shown below. An antenna may increase the transmission distance from a few cm to a couple of meters (I tested and got a fair quality from



around 10 meters)






[image: helical antenna]



Helical antenna







The transmitter operates at voltages between 3.3v and 12v (but check with your supplier), the higher the voltage the better the range. The pin out is as follows



●
 
 Arduino
 => Transmitter



●
 
 +5v
 => VCC



●
 
 GND
 => GND



●
 
 D12
 => DATA







The receiver operates at 5v only. I tried it with 3.3v but did not work. The receiver has 4 pins, 2 of them are labeled as DATA , you need to use only one, either or.



●
 
 Arduino
 => Receiver



●
 
 +5v
 => VCC



●
 
 GND
 => GND



●
 
 D11
 => DATA







The DATA pin can be attached to any digital pin on both modules. In my opinion, the best most robust Arduino library for Radio communication is the Radio Head library. I used Virtual Wire for some time but I had intermittent issues when using this library. It is also an old one as well. Radio Head on the other hand is well documented, periodically updated and supports multiple protocols and devices. You can download the library from
 


 
http://www.airspayce.com/mikem/arduino/RadioHead/

 .



The following is an example for sending a message from one Arduino to another by means of radio communication over 433Mhz band.








Prerequisites








●
 
 2x Arduino
 


 



●
 
 
 1x Transmitter
 


 



●
 
 
 1x Receiver
 


 



●
 
 
 Few Jumper wires
 








 
The Transmitter - Source Code








#include <RH_ASK.h>//including the library


#include <SPI.h>// this is not used but needed to compile




//So arguments are bitrate, transmit pin (tx),


//receive pin (rx), ppt pin, isInverse. The last 2 are not used.


RH_ASK driver(2000, 11, 12, 10, false);




void setup()


{


 Serial.begin(9600);
  // Debugging only


 if (!driver.init())


 Serial.println("init failed");


}




void loop()


{


 const char *msg = "Hello from RuntimeProjects.com";




 driver.send((uint8_t *)msg, strlen(msg)); //converting char array *msg to uint8_t and handing it over to the module to be sent


 driver.waitPacketSent(); //halt execution until all data has been sent


 delay(2000); //wait 2 seconds


}











The Receiver - Source Code








#include <RH_ASK.h>//including the library


#include <SPI.h>// this is not used but needed to compile




//So arguments are bitrate, transmit pin (tx),


//receive pin (rx), ppt pin, isInverse. The last 2 are not used.


RH_ASK driver(2000, 11, 12, 10, false);




void setup()


{


 Serial.begin(9600);
 // Debugging only


 if (!driver.init())


 Serial.println("init failed");


}




void loop()


{


 uint8_t buf[RH_ASK_MAX_MESSAGE_LEN]; //this is the buffer we use to save the received data


 uint8_t buflen = sizeof(buf); //




 if (driver.recv(buf, &buflen)) // Non-blocking


 {


int i;




// Message with a good checksum received, dump it.


driver.printBuffer("Got:", buf, buflen);


 }


}






This example transmitter will send “Hello from RuntimeProjects.com” to the receiver. The receiver will output the data received over serial.




























Bluetooth Tutorial HC-05








Bluetooth has been around for quite a while now. Being a common way to communicate with mobile phones, it was only natural to include this protocol in the Arduino arena.







Bluetooth is typically a low power, medium range device, in fact it can reach up to 10 meters. Bluetooth operates on the same frequencies as WiFi, 2.4Ghz.Connections are normally one to one meaning no group communication is allowed by the protocol. The connection is established by a master device, which connects to a slave device. In internet terminology the master is the client and the slave is the server. Certain devices can be configured to act as both master and slave (like the HC-05) while others are pre-programmed as slaves only (like the HC-06).







After a successful connection has been established the two devices can exchange data. Data is exchanged as bytes but there are libraries which make it easy to send strings and other data types in a transparent manner.



Can Arduino control a Bluetooth device? Of course, the most common devices are the HC-05 and HC-06. The difference between the two is that the HC-05 can act as a slave and as a master, while the HC-06 can act just as a slave. So don’t bother with the HC-06. In this section we will set up a slave HC-05 Bluetooth device and pair it with an Android phone. Then using a Bluetooth terminal found on the Android Play Store, we will be able to send commands to the Arduino and receive confirmation. We will try to switch the built in LED on pin 13, on and off.








Hardware needed








●
 
 1x Arduino Uno
 


 



●
 
 
 1x HC-05 Bluetooth Module
 


 



●
 
 
 4x Jumper wires
 

























Schematic Diagram






[image: hc-05-serial_schem]







hc-05 connections








Source Code








#include <SoftwareSerial.h>




SoftwareSerial mySerial(3, 2); // RX, TX




void setup() {


 // Open serial communications with the PC


 Serial.begin(57600);


 while (!Serial) {


 ; // wait for serial port


 }




 pinMode(13,OUTPUT);




 // set the data rate for the bluetooth communication port


 mySerial.begin(38400);//could be 9600 or any other




}




void loop() {


 if (mySerial.available()) {


 char x = mySerial.read();


 Serial.write(x);


 if (x == 'H') {


 digitalWrite(13,HIGH);


 mySerial.write("Ok - Turning On");


 }


 else if (x == 'L') {


 digitalWrite(13,LOW);


 mySerial.write("Ok - Turning Off");


 }


 else mySerial.write("Error");


 }


 if (Serial.available()) {


 mySerial.write(Serial.read());


 }


}






Now install a Bluetooth terminal on your phone and connect to the hc-05 module. Once connected try sending ‘H’ to switch the LED on and ‘L’ to switch it off. Anything else you send will return an error, kind of.














Solar Power your Arduino








Solar panels or solar cells are becoming extremely popular as an alternative source of energy to power an Arduino. These are the 2 major setups which serve different purposes. First, the Arduino board can be powered directly from a solar panel or a set of solar panels. Secondly, and the more robust approach is to install a battery pack along with the solar panels. The batteries are charged by the solar panels while the batteries provide reliable power to the circuit.







We’ll talk about the 2 methods but let's set the grounds straight first. Solar panels can be regarded as a source of energy like a battery with the exception that solar panels depend directly on sunlight. This does not only mean that during the night the solar panel won’t generate any power, it means that whenever the intensity of sunlight changes, the output power changes as well. Having said that, the choice of whether to add a battery pack or not should be easy. Basically, if a battery is used, the Arduino uses the power from the battery and the solar panel charges the battery when sunlight is available. The advantage of this setup is that your Arduino will keep running even on cloudy days, even during the night. Another less obvious advantage is that the output power is stable from the battery. No dips or spikes in power are felt by the Arduino.







Connecting the Arduino directly to the solar panel is probably undesirable, but possible still. In an environment where sunlight is abundant and downtime of the system is not an issue, a battery-less solutions might be cheaper, simpler and smaller in size.







Choosing a solar panel is a difficult a tedious task. First of all you need to know up front your power requirements in volts and amps. For example, let's say we need minimum of 5v, 100mA we need to use solar panels rated minimum at 7v, 150mA nominal. The panels will almost never reach nominal values, but in direct sunlight with an angle perpendicular to the Sun, the values will be very close. The battery (if any) has to be considered as well. Imagine having a 7.5v battery to power a 5v Arduino board. In this case although the board runs at 5v, we cannot use a solar panel rated 7v because we need to charge the battery. So a solar panel with higher voltage is chosen, for example 9v. Remember that different batteries require different protection circuits to be charged properly. So basically you cannot simply connect a battery directly to the solar panel/s.







Solar Panels come in different shapes and sizes, and power per square inch. An efficient solar panel is more attractive because it takes up less space for the same amount of power. In certain projects, flexible solar panels are ideal. They are normally very thin and very light rendering them the best option for aircraft and other light vessels.







Arduino is a very efficient device. In fact it can run with as low as 25mA in normal conditions and with as little as 5mA on sleep mode. So this makes Arduino a perfect device for solar projects.



 














ESP8266 – Environment Setup









Introduction








The Internet of Things is a relatively new concept in the world of electronics. It was also quite expensive and maybe even unreachable by some hobbyists. The introduction of the ESP8266 changed that perception forever. Being first designed as a simple Serial WiFi adapter; today it is the most common IoT device among electronic hobbyists and hackers alike. The ESP is cheap, small, powerful and easy to program as you shall see in a jiffy. This tutorial will focus on the ESP-01 model.


[image: ESP8266_Wi-Fi_Module]
 There are many versions and different boards with the ESP8266, in this tutorial we will focus on the most common and cheapest model the ESP-01. This little board comes pre-installed with the original firmware which allows it to act as a Serial WiFi module; however, this firmware is of little use to us. Together we are going through the process of transforming a WiFi Module into a fully-fledged standalone WiFi enabled Arduino.







ESP8266 Wi-Fi Module







First and foremost it is very important to note that the ESP8266 is
 not
 5V tolerant. VCC and all other pins must be fed 3.3V only. Apart from that the ESP-01 cannot be programmed directly because it does not have a USB port and is not even RS232 compatible. We will need an FTDI 3.3V like the one below.


[image: ftdi]



FTDI







Now all you need are some jumper wires to connect the ESP with the FTDI.








Connections








●
 
 ESP-01
 FTDI



●
 
 VCC
 => VCC (remember 3.3V only)



●
 
 GND
 => GND



●
 
 RX
 => TX



●
 
 TX
 => RX



●
 
 CH_PD
 => VCC



●
 
 GPIO 0
 => GND (only used to flash the module with new software)






[image: esp8266 connections reflash]
 esp8266 connections reflash







Done that, grab a USB cable and plug it in the FTDI and your PC.








Environment Setup




●
 
 Start Arduino IDE



●
 
 Go to
 File > Preferences
 .



●
 
 Enter http://arduino.esp8266.com/stable/package_esp8266com_index.json in
 Additional Board Manager URLs
 field. You can add multiple URLs, separating them with commas.



●
 
 Open Boards Manager from
 Tools > Board
 menu and find
 esp8266
 platform.



●
 
 Select the latest version



●
 
 Click
 install
 button.



●
 
 Go to
 Tool > Boards
 and select
 Generic ESP8266








Testing








All set and ready to code. Make sure your ESP is plugged in. Go to Tools > Port and select the COM port which the ESP is connected to. Then paste the code below. It’s a simple blink program to test our setup.







void setup() {


 pinMode(LED_BUILTIN, OUTPUT); // Initialize the LED_BUILTIN pin as an output


}




// the loop function runs over and over again forever


void loop() {


 digitalWrite(LED_BUILTIN, LOW); // Turn the LED on (Note that LOW is the voltage level


 // but actually the LED is on; this is because


 // it is active low on the ESP-01)


 delay(1000); // Wait for a second


 digitalWrite(LED_BUILTIN, HIGH); // Turn the LED off by making the voltage HIGH


 delay(2000); // Wait for two seconds (to demonstrate the active low LED)


}






If the LED blinks, you’re done. The setup is complete and you can start experimenting with your ESP-01.










ESP8266 - Connect to WiFi and Download data from the Internet








In part one of this series, we gave an introduction to the ESP8266, setting the IDE and the circuitry needed to get started. In this post, we will go through some basic software capabilities particularly connecting to a WiFi network, and establishing a connection to a web server to download data.







The ESP8266 is not an Arduino, it is only WiFi to serial device turned into a powerful Arduino compatible device. Thanks to a great number of people, this device can now be programmed using the Arduino IDE and almost all of its basic functionality is readily available through a library. In principle, the ESP8266 cannot replace the Arduino board for all projects, primarily due to higher power consumption and the lack of an advanced ADC. The ESP board has only 1 ADC with values from 0 to 1 volt. This pin is NOT available on the ESP-01.



Let me introduce you to the ESP board using some actual code.



The device can act as a WiFi station (like your laptop) or as a Access Point. And if you want to make things really fun, try mode 3… In mode 3 the esp8266 turns into both an AP and a Station. That means, the ESP can be connected to an AP while listening for WiFi clients at the same time.







Thanks to the ESP8266 library, these features are exposed as normal Arduino library functions. Lets begin by establishing a connection to an AP using our little ESP.



We will use a modified version of the example called WifiClient.ino in the examples provided by the library. In our example we will access an RSS feed. Any RSS feed you want







#include <ESP8266WiFi.h>




const char* ssid = "your-ssid";


const char* password = "your-password";




const char* host = "runtimeprojects.com";








First we begin by called the library definition so we can use the functions provided by the ESP8266 Android library. The next two lines are your WiFi SSID (the name of your WiFi) and the password. The host is the hostname you intend to get the feed from, just the hostname; the path to the page will be requested later.







void setup() {


 Serial.begin(115200);


 delay(10);




 // We start by connecting to a WiFi network




 Serial.println();


 Serial.println();


 Serial.print("Connecting to ");


 Serial.println(ssid);





 WiFi.begin(ssid, password);





 while (WiFi.status() != WL_CONNECTED) {


 delay(500);


 Serial.print(".");


 }




 Serial.println("");


 Serial.println("WiFi connected");


 Serial.println("IP address: ");


 Serial.println(WiFi.localIP());


}










The first few lines are normal Serial.println. The interesting part begins at line WiFi.begin(ssid, password); Here we are instructing the ESP to connect to the network. Next we wait for a connection. We check the WiFi.status for the connection status. When the result is equal to ‘WL_CONNECTED’ we stop searching.











while (WiFi.status() != WL_CONNECTED) {


 delay(500);


 Serial.print(".");


 }








then we print the obtained IP address with Serial.println(WiFi.localIP());



Great!! We are now connected to the network. Now let’s download some data.







void loop() {


 delay(5000);




 Serial.print("connecting to ");


 Serial.println(host);





 // Use WiFiClient class to create TCP connections


 WiFiClient client;


 const int httpPort = 80;


 if (!client.connect(host, httpPort)) {


 Serial.println("connection failed");


 return;


 }






In the loop() we create the connection, send the HTTP headers and retrieves data from the server. We create the connection by invoking







client.connect(host, httpPort);







The connection is placed inside an if statement because the connect function returns boolean. If a connection is established the if statement is skipped.







// We now create a URI for the request


 String url = "/feed/"




 Serial.print("Requesting URL: ");


 Serial.println(url);




// This will send the request to the server


 client.print(String("GET ") + url + " HTTP/1.1\r\n" +


 "Host: " + host + "\r\n" +


 "Connection: close\r\n\r\n");


 unsigned long timeout = millis();


 while (client.available() == 0) {


 if (millis() - timeout > 5000) {


 Serial.println(">>> Client Timeout !");


 client.stop();


 return;


 }


 }








The function client.print sends the HTTP request to the server (very simple request but it should work ). We then check if the client sends some data if not we wait 5000 milliseconds; if no data is sent after 5000 milliseconds the connection is broken.







// Read all the lines of the reply from server and print them to Serial




 while(client.available()){


 String line = client.readStringUntil('\r');


 Serial.print(line);


 }





 Serial.println();


 Serial.println("closing connection");


}




Finally, we check if the client object (the connection) is still available, then we read the response line by line.



So that was a very basic method of how to download some data from a website via TCP and HTTP protocol and port 80














Running a simple Web Server








Last time you learned how to connect the ESP8266 to a WiFi network and download data from a URL. Today we will explore a way to listen to connections just like a server; a web server in fact. The ESP will listen for connections on port 80 and will serve simple pages to connected clients. For this example, a different approach will be taken to program the ESP8266. The structure we used in our last tutorial was purely procedural. The problem with procedural structured programs is that it is difficult and messy to handle multiple simultaneous connections. In this example we will use handlers which are a way of structuring our programs to serve multiple clients and at the same time keeping the code pretty.







The code will listen for connections on port 80 and will serve a web page showing a link with “LED On” or “LED Off”. Once clicked the on board LED switches on or off respectively. The on board LED is on GPIO 1, the pin used by TXD, so we won’t be able to use Serial.print() in our program.







We start off with the basics. Loading libraries and connecting to a WiFi network.







#include <ESP8266WiFi.h>


#include <WiFiClient.h>


#include <ESP8266WebServer.h>


#include <ESP8266mDNS.h>




const char* ssid = "your wifi SSID";


const char* password = "password";




ESP8266WebServer server(80);




MDNSResponder mdns;




String pageTurnOn = "<html><body><h1>LED is ON</h1><a href=\"/turnoff\">Turn Off</a></body></html>";




String pageTurnOff = "<html><body><h1>LED is OFF</h1><a href=\"/turnon\">Turn On</a></body></html>";




void setup() {




 pinMode(LED_BUILTIN, OUTPUT);




 WiFi.begin(ssid, password);




 delay(1000);




 while (WiFi.status() != WL_CONNECTED) {


 delay(200);




 //a flashing LED means the ESP is not connected


 digitalWrite(LED_BUILTIN,!digitalRead(LED_BUILTIN));


 }




 //a stable LED on means the ESP is now connected


 digitalWrite(LED_BUILTIN,true);




 mdns.begin("esp8266", WiFi.localIP());






Do not forget to to change the SSID and PASSWORD for your own.



MDNSResponder lets us name our ESP8266 and use it instead of the IP address. Think of it as a personal local domain. The LED_BUILTIN is the LED on board the ESP which is connected to GPIO1. “digitalWrite(LED_BUILTIN,!digitalRead(LED_BUILTIN));” line will keep the LED flashing until a connection to the WiFi network is established. Then we call the MDNS to allow us to use the name “esp8266.local”. Next we define our commands which are basically calls for a different web page.







server.on("/turnon", [](){


 server.send(200, "text/html", pageTurnOn);




 digitalWrite(LED_BUILTIN,HIGH);




});




server.on("/turnoff", [](){


 server.send(200, "text/html", pageTurnOff);




 digitalWrite(LED_BUILTIN,LOW);


});




 server.onNotFound([](){




 server.send(404, "text/html", "Command Not Found");




 });




 server.begin();




}




void loop(void){


 server.handleClient();


}








The structure server.on acts just like events. When a certain criteria (the page) are met, execute some commands.







server.on(“/turnon”, [](){



 server.send(200, “text/html”, pageTurnOn);



 digitalWrite(LED_BUILTIN,HIGH);



});







The lines in red are part of the handler declaration, while the green ones are the operations to be executed once this handler is triggered.



The server.send is the command we use to send the web page to clients. The 200 is the HTTP server error code which in this case is OK. The second is the type of data called mime type.







Our server can now be accessed from this url http://esp8266.local/turnon



When we access esp8266.local/turnon the LED is turned on and the page with text in pageTurnOn var will be sent to the client, and provides a link to turn off the led.



The server.onNotFound is a special handler. It processes requests which are not part of any server.on. So the notFound is triggered when we don’t know what the client sent us. This time we are sending a different error code, error 404, Not Found














ESP8266 - How to turn your ESP8266 into an Access Point








Last time we hosted a simple web server on an ESP8266. Today we are going a step further, we are going to turn the ESP8266 into an access point (AP). Yes, then you can connect to the ESP8266 via your phone or laptop, or any other device for that matter. As you will see the Arduino core library makes it really easy to initialize the AP mode instead of the station mode. Almost all functions will work in the same manner in both modes.



As an example, to keep things as simple as possible, we will just turn the ESP8266 into a WiFi access point and then you can add what we learned in
 


 Part 3 to host a simple web page on the access point!! Let’s start with the AP mode first.







#include <ESP8266WiFi.h>




const char *ssid = "myESPNetwork";


const char *password = "thisESPisProtected"; //the password should be 8 char or more




//setting the addresses


IPAddress ip(192,168,8,1);


IPAddress gateway(192, 168, 8, 1);


IPAddress subnet(255, 255, 255, 0);




void setup() {


 WiFi.mode(WIFI_AP); //switching to AP mode


 WiFi.softAP(ssid, password); //initializing the AP with ssid and password. This will create a WPA2-PSK secured AP




 WiFi.config(ip,gateway,subnet);


 WiFi.begin();




}




void loop() {




}






As you can see it is very simple to turn the ESP8266 into a router. First, we give the ESP an SSID (the wifi name which will be visible) and a password (with WPA2-PSK security). Next we set some addresses, first the IP address of the ESP, the access point, the gateway can be any device on the network which will provide internet access or access to other networks. Then the subnet, which … ohh never mind, not important!!



Next up we set the ESP in AP mode and giving it an ssid and password in the setup function. Assign the addresses with WiFi.config and start the AP with WiFi.begin.



Now fetch your mobile or laptop, search for your new WiFi access point and connect. You will find that however small the ESP8266 has a very powerful transmitter. In the next tutorial you will see how you can use your ESP8266 for a simple WiFi bridge between an existing network and the newly created one.














Arduino Cellular Automata




This project uses an I2C 128  64 OLED to display a tiny cellular automata powered by Arduino Nano.



Prerequisites



●
 
 2x half size breadboard
 


 (or 1x standard)



●
 
 1x Arduino Nano
 


 (can be Uno as well)



●
 
 1x OLED I2C 12864
 


 



●
 
 
 4x Jumper Wires
 


 



 Assumptions



During this tutorial I will assume that you know what an Arduino is (o_O) and you know how to use the IDE and upload simple sketches. I will also assume you know a little programming preferably C programming.



So let's get started!!



Background



What is Cellular Automata? I will explain 1 type of cellular automata which is the Game of Life by John Conway. It is a grid or cells each having 2 states True or False/on or off/alive or dead. These cells are governed by 2 simple rules:



Rule 1
 : A cell which is dead and is surrounded by exactly 3 alive cells, will be born



Rule 2:
 A cell which is alive and has either 3 or 2 alive cells will remain alive, else it dies



Simple, no? If you need more information make a little visit to the
 


 
Game Of Life

 or
 


 
Cellular Automata

 on Wikipedia.







Circuitry



So hook up the Arduino and OLED LCD to the breadboard and start wiring.



●
 
 Arduino —– OLED



●
 
 3.3v ———— VCC (pay attention to your OLED voltage requirements)



●
 
 GND ———– GND



●
 
 A4 ————– SDA



●
 
 A5 ————– SCL



Then I attached both breadboards back to back and created a small TV
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Programming the sketch




In order to facilitate (and make it possible) to play with the OLED display, we will be using 2 libraries from Adafruit. If you don’t know how to add libraries please visit
 


 
https://www.arduino.cc/en/Guide/Libraries




	
 Adafruit GFX library which will be used to handle all graphics and text displayed on the OLED
 
https://github.com/adafruit/Adafruit-GFX-Library



	
 Adafruit SSD1306 library which basically is the driver for our OLED. This library works only with OLED SSD1306 12832 and 12864
 


 
https://github.com/adafruit/Adafruit_SSD1306






 The sketch can be downloaded from our github:
 


 
https://github.com/klauscam/Arduino-Cellular-Automata/




On line 51 with code



display.begin(SSD1306_SWITCHCAPVCC, 0x3C); //initialize with the I2C addr 0x3C (128x64)



the address, which is the 0x3C might be different. I searched for the most obvious and tried a few before getting it to work.







Working Product



Check out a working product on Youtube
 
https://youtu.be/CQOH0VfyzZQ




The visible horizontal lines are the result of refresh rates of the OLED and the camera.
 
 




Arduino Frequency Counter with 162 LCD Display




Recently, a friend of mine had an issue with his car’s ECU and needed a frequency counting device. The solution was a device to determine the pulse frequency emitted by the ECU against the rev counter.



So, the device had to have the ability to read digital pulses, between 1v – 5v, which are then interpreted by a digital pin on the arduino as HIGH and LOW pulses. Then, it will output the frequency in hz/khz on the LCD display.



Hardware



1x Arduino Uno
 


 



 1x 162 LCD SPI (not the I2C)
 


 



 3x jumper wires
 


 



 The Setup



I had bought a 162 LCD and never actually did anything with it, so it was about time The LCD was in the form of a shield compatible with Arduino Uno.



I snapped the LCD onto the Arduino and attached a jumper wire to analog pin A5. I am still using digital input in my code but since almost all digital pins were taken by the LCD I’ve decided to utilize an analog pin.



Now, the device can be powered via the USB port, the jack pin or the VIN. I am using the VIN here as I had no jack available and I was using the car’s supply (roughly 12v-14v).



Circuit



If using the LCD shield you can skip this part, but if you don’t have a shield here are the connections that are needed.



●
 
 LCD
 Arduino



●
 
 RS
 12



●
 
 Enable
 11



●
 
 D4
 5



●
 
 D5
 4



●
 
 D6
 3



●
 
 D7
 2



●
 
 R/W
 GND



●
 
 VSS
 GND



●
 
 VCC
 +5V



Add 10k Ohm resistor between +v5 and GND



Plug in the +12v of the battery in Arduino VIN pin and GND of the battery to Arduino GND.



Finally the A1 pin jumper wire to the source of the frequency to be measured.



NOTE: In my case both the ECU and the Arduino had their GND connected (at the GND Terminal of the battery).



The Sketch



The sketch is fairly simple. We will display 3 values on screen. The current frequency, the max frequency and the min frequency, will be updating every second. The min and max are reset every 5 minutes.



We are using the LiquidCrystal.h which is included in the Arduino IDE installation, so you don’t need to add anything.



Source code
 :
 Download
 


 
https://github.com/klauscam/Arduino-Frequency-Counter




 Limitations



We tested the device using another arduino (which probably it’s not the best thing to do) and found that up to 50 khz the device had an error of around +/- 3% so it’s actually pretty good.



Beyond 50 khz, the error started to rise and became very inaccurate. So our suggestion is to use it only for frequencies under 50 khz.


















A Lightning Detector for Arduino








In this tutorial, we will build a lightning detector using an Arduino Uno, a few resistors and some jumper wires. Most lightning detectors often cost too much for the normal hobbyist, however this does not mean one cannot enjoy lightning detection and the physics behind it. In this tutorial, using a surprisingly simple circuit we will be able to detect lightning from around 10-20 km away, which is to say the least impressive.



The aim is to construct a simple circuit to detect lightning with an Arduino and produce meaningful results.




Background




When a lightning strikes, a huge amount of energy is released in different forms. The most obvious are light and sound, the latter being a by-product of the rate of temperature increase of the immediate particles surrounding the lightning bolt, which then causes the sound. But, that is not all. Lightning emit large amount of electromagnetic radiation in the VLF (Very Low Frequency) and LF (Low Frequency) range, typically ranging from 3 kHz to 300 kHz. VLF and LF are similar to light waves, your WiFi waves and also your microwave oven waves, but with the difference of operating at lower frequencies. eg. WiFi normally operates at around 2.4GHz, that’s 2.4 billion oscillations per second. VLF and LF operates at lower frequencies, and with an Arduino we can capture frequencies around 7kHz. The advantages in using this kind of radiation for lightning detection is that normally nothing gives out large bursts as seen in a lightning strike, around this frequency; and being an electromagnetic wave it travels at the speed of light, which means the sensor will detect lightning as they happen (a few microseconds after).



Our little Arduino will have an antenna (sort of), a piece of wire that will pick fluctuations in electromagnetic spectrum specifically around the 7-9kHz. These fluctuations will induce a small voltage +ve or -ve in the wire. We can pick these fluctuations using Arduino’s analog pins.




Prerequisites




●
 
 2x10k Ohms Resistor
 



●
 
 
 1x 3.3M Ohms Resistor



●
 
 4x Jumper Wires



●
 
 1x Arduino
 


 (I’m using Uno but any other will work as long as it can operate at 16Mhz)



●
 
 Breadboard







As you might already know, the pins on the Arduino board allow for voltages between 0v and 5v, anything below 0v and above 5v will not be read, hence data will be lost. More importantly, voltages below 0v will potentially damage the pin. This will create a little problem for us because the voltages produced in the wire fluctuate below and above 0v. To solve this problem we set the pin voltage in the middle of the 5v range, at 2.5v and this will be accomplished using a little trick, a voltage divider. In doing so, we will be setting the pin to a steady 2.5v and the voltage fluctuations will have an origin of 2.5v, hence no damage or loss of data.



Lightning Detector Circuit Diagram
 [image: Lightning Detector]
 Lightning Detector



The circuit is pretty straight forward, we have 2x 10k Ohm resistors in series from 5v (red wire) to GND (black wire), this is basically the voltage divider. Then a 3.3M Ohm (Mega Ohm) resistor is connected between the 2x 10k Ohm resistors. In series with the 3.3M Ohm resistor attach a wire to pin A4 (blue wire), this will give us exactly 2.5v on pin A4. Then attach a wire which will act as an antenna (green wire) of around 6-8 inch in length. This should be connected from one end only as shown above.




Sketch




Here comes the hardest part to explain. As mentioned above, the frequency we need to pick up from the lightning is around 7 kHz and to read a semi-decent wave the sample rate has to be 4x as much, giving us 4 readings per wavelength. That is, 28,000 samples per second.



The Arduino analog pins can only give us 9,600 samples per seconds. With that sample rate we will only be able to capture waves at 2 kHz or a bit more, which is far from good. Thanks to the ATMEGA chip, it can be configured to speed up the ADC process by a certain factor, while retaining a good resolution. This is called the prescaler, and can be configured through code. There are a number of prescaler dividing factors but we will use factor 16 which in theory will give us a sampling rate of 77 kHz. In practice any form of calculation will lower this sampling rate thus I was only able to get around 46 kHz which is still very good for this project.



So moving forward, the sketch uses a 512 byte array to store voltage valves from pin A4. It constantly reads the pin value and writing it to the next location in the array. As soon as a lightning is detected the whole array is sent over the serial port. This can be plotted on the graph plotter in Arduino IDE or maybe sent over to another Arduino or ESP8266 to publish the data online. It’s probably best to monitor it via the Arduino IDE at first, so if there are some glitches, they can be tackled there and then.














Results




The following are some results.


[image: lightningexmple-2]
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Grab the source code from Github:
 


 
https://github.com/klauscam/Arduino-Lightning-Detector




 To use the Arduino IDE serial plotter, please replace this function



void sendData()


{


// Serial.print(">>>");


// Serial.println(batchStarted);





 for (int i=0;i<data;i++){


 Serial.println(storage[i]);


 }


// Serial.print("<<<");


// Serial.println(batchEnded);


// Serial.println("END");





 toSend=false;


}






Note that the device is very sensitive to EMF fluctuations. This includes AC power supplies. Place the device away from any AC supply and any socket outlets. We have also noticed that it behaves abnormal when connected to a laptop while charging. We recommend to use a laptop running on batteries only for optimum performance.














Messing with WiFi protocol, Esp8266 and fake APs




I was browsing the internet on a rainy day, and stumbled upon some cool stuff. The ESP8266, apart from being a super chip, which can be turned into a station and an access point, it can also do some weird stuff at the lowest possible level on the WiFi protocol. wifi_send_pkt_freedom() is a function built in Arduino Core which enables the chip to send out arbitrary WiFi packets.



That means a lot. Everything that is sent out in the air, is being sent using packets. Some of these packets may be plain text other are encrypted with a key that is shared between an access point and the connected station. As I said, everything is sent out as packets, even which device sent the packets and also its destination.



On github I came across a piece of code which creates multiple fake access points which pop up and disappear almost instantly. This code produces some 100 access points per second with random SSIDs and MAC addresses. This is done simply by sending out a series of packets with the SSID and MAC address parts being randomly generated.



While this code should not cause harm to anyone, we cannot rule out that some old devices might not handle the amount of access points at one go and might also be illegal in your country. Please use it with caution; we are not responsible for any malicious and/or illegal activity.



Original code can be found
 


 
https://github.com/kripthor/WiFiBeaconJam/blob/master/WiFiBeaconJam.ino




 




Source Code








#include <ESP8266WiFi.h>




extern "C" {


 #include "user_interface.h"


}




String alfa = "1234567890qwertyuiopasdfghjkklzxcvbnm QWERTYUIOPASDFGHJKLZXCVBNM_";


byte channel;




// Beacon Packet buffer


uint8_t packet[128] = { 0x80, 0x00, 0x00, 0x00,


 /*4*/ 0xff, 0xff, 0xff, 0xff, 0xff, 0xff,


 /*10*/ 0x01, 0x02, 0x03, 0x04, 0x05, 0x06,


 /*16*/ 0x01, 0x02, 0x03, 0x04, 0x05, 0x06,


 /*22*/ 0xc0, 0x6c,


 /*24*/ 0x83, 0x51, 0xf7, 0x8f, 0x0f, 0x00, 0x00, 0x00,


 /*32*/ 0x64, 0x00,


 /*34*/ 0x01, 0x04,


 /* SSID */


 /*36*/ 0x00, 0x06, 0x72, 0x72, 0x72, 0x72, 0x72, 0x72,


 0x01, 0x08, 0x82, 0x84,


 0x8b, 0x96, 0x24, 0x30, 0x48, 0x6c, 0x03, 0x01,


 /*56*/ 0x04};






void setup() {


 delay(500);


 wifi_set_opmode(STATION_MODE);


 wifi_promiscuous_enable(1);


}








void loop() {


 // Randomize channel //





 channel = random(1,12);


 wifi_set_channel(channel);




 // Randomize SRC MAC


 packet[10] = packet[16] = random(256);


 packet[11] = packet[17] = random(256);


 packet[12] = packet[18] = random(256);


 packet[13] = packet[19] = random(256);


 packet[14] = packet[20] = random(256);


 packet[15] = packet[21] = random(256);




 // Randomize SSID (Fixed size 6. Lazy right?)


 packet[38] = alfa[random(65)];


 packet[39] = alfa[random(65)];


 packet[40] = alfa[random(65)];


 packet[41] = alfa[random(65)];


 packet[42] = alfa[random(65)];


 packet[43] = alfa[random(65)];





 packet[56] = channel;





 wifi_send_pkt_freedom(packet, 57, 0);


 wifi_send_pkt_freedom(packet, 57, 0);


 wifi_send_pkt_freedom(packet, 57, 0);


 delay(1);


}














Extend WiFi with an ESP8266








The ESP8266 is known for its powerful features and performance despite its small size. However few knew it could act as a WiFi extender/repeater. From previous lessons, we learned how to make the ESP8266 act as both a station and an access point. Now we are going to use that functionality at the same time with a little twist. Unfortunately the standard firmware is not capable of forwarding packets between the local network (the network which is hosted by the ESP8266) and the intra network (the network which the esp8266 is connected to). That means we need a custom firmware which luckily someone on Github managed to do. The source code is public and open source. However, we need not edit any code. When we update the new firmware we are ready to go (almost).



Part 1: Flashing the ESP8266 with a custom firmware.



Step 1
 :



Start by navigating to
 


 
https://github.com/martin-ger/esp_wifi_repeater

 In case you have an ESP-01 navigate to folder “firmware_sdk_1.5.4” and download files ‘0x00000.bin’ and ‘0x40000.bin’. For all other boards go to folder “firmware” and download files ‘0x00000.bin’ and ‘0x10000.bin’



Step 2
 :



Grab an ESP8266, connect it to your computer for flashing, so you need to bring GPIO0 down by grounding it.



Step 3
 :



Now head to the Espressif website
 


 
https://espressif.com/en/support/download/other-tools

 and download the “Flash Download Tools V3.4.4”.



Step 4
 :



Set settings detailed in this diagram


[image: esp8266flash]



esp8266flash



Remember to replace 0x10000.bin for 0x40000.bin when using ESP-01 boards.



Step 5
 :



Hit Start and let it flash…. until it has finished. It will take a few seconds to flash.



Part 2: Setting the ESP8266



Use the IDE Serial monitor. Set the COM port of your ESP8266 and set baud rate at 115200.



The following is a list of commands to use. I have noticed that the ‘help’ command is empty for the ESP-01 versions.



●
 
 help: prints a short help message



●
 
 show [config|stats]: prints the current config or some statistics



●
 
 set [ssid|password|ap_ssid|ap_password] value: changes the named config parameter



●
 
 set ap_open [0|1]: selects, whether the soft-AP uses WPA2 security (ap_open=0) or no password (ap_open=1)



●
 
 set ap_on [0|1]: selects, whether the soft-AP is disabled (ap_on=0) or enabled (ap_on=1)



●
 
 set network ip-addr: sets the IP address of the internal network, network is always /24, router is always x.x.x.1



●
 
 set speed [80|160]: sets the CPU clock frequency



●
 
 set vmin voltage: sets the minimum battery voltage in mV. If Vdd drops below, the ESP goes into deep sleep. If 0, nothing happens



●
 
 set vmin_sleep time: sets the time interval in seconds the ESP sleeps on low voltage



●
 
 set config_port portno: sets the port number of the console login (default is 7777, 0 disables remote console config)



●
 
 portmap add [TCP|UDP] external_port internal_ip internal_port: adds a port forwarding



●
 
 portmap remove [TCP|UDP] external_port: deletes a port forwarding



●
 
 save [dhcp]: saves the current config parameters [+ the current DHCP leases] to flash



●
 
 quit: terminates a remote session



●
 
 reset [factory]: resets the esp, optionally resets WiFi params to default values



●
 
 lock: locks the current config, changes are not allowed



●
 
 unlock password: unlocks the config, requires password of the network AP



●
 
 scan: does a scan for APs



●
 
 monitor [on|off] port: starts and stops monitor server on a given port



Now let us try to connect to our network and extend our network using the ESP8266. Our network is ‘
 runtimenet
 ‘ password ‘
 helloruntime
 ‘.



In order to configure the ESP the following commands should be executed.



set ssid runtimenet


set password helloruntime






Configure the AP we want to broadcast:



set ap_ssid mynewap


set ap_password newpassword


set ap_open 0


set ap_on 1






Then save the configuration to flash.



save






Now give it some time and it will connect to the network. You will also notice you can connect to its WiFi named ‘mynewap’ with password ‘newpassword’.



Make sure the ESP is connected to your main WiFi network. If so, try to connect with the ESP and once connected you should be able to access the Internet via your ESP8266.














Keep accurate time using Real Time Clock (RTC)








The Arduino board can keep time using millis() which increment from boot up till shutdown, then it will start over again. But what if we needed to keep time indefinitely, independently whether the board is switched on or off? What if we don’t want millis() but we want the year, month, day and time? How do we compensate for leap years?



No worries. We are fortunate enough to have the DS1307 Real Time Clock and Adafruit has provided us with a really good library to access all its features. The module requires a CR1225 (or other) battery to keep running even when you pull the plug on the Arduino.



Setup



Remember to download and install the Adafruit library for the RTC which can be found here (
 
https://github.com/adafruit/RTClib

 ). If you have problems installing the library follow our tutorial here (
 
http://runtimeprojects.com/2016/03/arduino-beginners-course-lesson-5-installing-and-using-libraries/

 ).



The RTC requires only 4 pins to connect it on the Arduino Uno, as follows:



●
 
 RTC
 Arduino



●
 
 +5V
 VCC



●
 
 GND
 GND



●
 
 SCL
 A5



●
 
 SDA
 A4



The SQW is a square-wave output and it’s optional. Most of us do not require this pin so we will leave it aside for now.



The Sketch



The following sketch is intended to demonstrate how we can use the RTC library. We will output the current date and time to serial, then do some calculations on the date and time, and output it again.



Let’s start by including libraries.



#include


#include "RTClib.h"






The following lines create the RTC object and create a list of days of the week, in English.



RTC_DS1307 rtc;




char daysOfTheWeek[7][12] = {"Sunday", "Monday", "Tuesday", "Wednesday", "Thursday", "Friday", "Saturday"};






Next up is the setup function. Here we’re initializing the Serial object and the RTC object.



void setup () {


 Serial.begin(57600);


 if (! rtc.begin()) {


 Serial.println("Couldn't find RTC");


 while (1);


 }




 if (! rtc.isrunning()) {


 Serial.println("RTC is NOT running!");





 } else {





 // following line sets the RTC to the date & time this sketch was compiled


 rtc.adjust(DateTime(F(__DATE__), F(__TIME__)));







 // This line sets the RTC with an explicit date & time, for example to set


 // January 21, 2014 at 3am you would call:


 // rtc.adjust(DateTime(2014, 1, 21, 3, 0, 0));


 }


}








In order to set an accurate time we use the



rtc.adjust(DateTime(F(__DATE__), F(__TIME__)));



This will initialize the RTC with the time the sketch is compiled, obviously using the date and time of your PCs.















In the loop function we make use of the ‘now’ object of type DateTime to store the current time, then output the required date information to serial port.



void loop () {


 DateTime now = rtc.now();





 Serial.print(now.year(), DEC);


 Serial.print('/');


 Serial.print(now.month(), DEC);


 Serial.print('/');


 Serial.print(now.day(), DEC);


 Serial.print(" (");


 Serial.print(daysOfTheWeek[now.dayOfTheWeek()]);


 Serial.print(") ");


 Serial.print(now.hour(), DEC);


 Serial.print(':');


 Serial.print(now.minute(), DEC);


 Serial.print(':');


 Serial.print(now.second(), DEC);


 Serial.println();





 Serial.print(" since midnight 1/1/1970 = ");


 Serial.print(now.unixtime());


 Serial.print("s = ");


 Serial.print(now.unixtime() / 86400L);


 Serial.println("d");








We can do more with this library. We can go backward and forward in time using the TimeSpan type.



Here we created another instance of DateTime called ‘future’, with the difference that we pass the ‘now’ parameter, which is the current date time object, and we add a time span of 7 days, 2 hours, 30 minutes and 6 seconds to the current time. We then output the future date and time to the serial port.



 DateTime future (now + TimeSpan(7,2,30,6));





 Serial.print(" now + 7d + 30s: ");


 Serial.print(future.year(), DEC);


 Serial.print('/');


 Serial.print(future.month(), DEC);


 Serial.print('/');


 Serial.print(future.day(), DEC);


 Serial.print(' ');


 Serial.print(future.hour(), DEC);


 Serial.print(':');


 Serial.print(future.minute(), DEC);


 Serial.print(':');


 Serial.print(future.second(), DEC);


 Serial.println();





 Serial.println();


 delay(3000);


}






That is how to use an RTC DS1307. Other chipsets may work but we had no experience with any other.










Detect Vibrations using a Piezo Element




A rather simple, cheap, yet effective way to detect vibrations is by using a piezo element. The piezo element is an electrical component found in many commercial products to detect impacts, vibrations, pressure and also to produce sound.



The piezoelectric effect (as it is known) was discovered in 1880 by French physicists Jacques and Pierre Curie. By definition the piezoelectric effect is the electric charge accumulated in certain solid materials in response to applied mechanical stress. That’s what piezo means in Greek, to stress, squeeze or press. When the materials in the piezo element are pressed, they generate a charge proportional to the applied mechanical stress. And this charge is very useful to us Arduino builders!



So the piezo element has 2 distinctive features and uses. We can either use it as an input source to detect fluctuations in voltage when a pressure is applied to the element; or we can apply a voltage with a certain frequency to produce sound waves (like the buzzer in your UPS and wrist watch).



How it works?



It should be noted that the piezo element works only when the pressure or voltage applied is changing at a particular frequency. This means that if you connect the piezo to a linear 1.5v source, like a battery, it will not produce any sound. Likewise, if you are detecting a press on the piezo, it will detect only the change in pressure. Bottom line, “When pressure/voltage are constant the piezo element will not react.”



So how do we use it effectively? As an example we will build a simple vibration sensor which theoretically can detect very small vibrations, even small seismic tremors. The setup is very simple.



Setup



Grab an Arduino and a piezo element. Connect the black wire of the piezo element to Ground and the red wire to analog pin 1. Now place the piezo element on a table and a heavy object on top of it. 500g object resting on the piezo element would be a good start. That’s all, now how do we capture the data.



















Data Acquisition and Presentation



The code provided will send out readings from the analog pin between 0 and 1023 to the serial output. To keep things simple, we can display the data in a graph using the plot functionality in the Arduino IDE. Go to Tools > Serial Plotter.



You should see a straight line on value 0. Now try and knock on the table… You should see vibration waves on the serial plotter. The harder you knock the bigger the waves.



Why did we add a weight? The piezo element works when there is change of pressure applied to it. Without weight vibrations on coming from the table will not induce pressure changes to the piezo element. However when adding a weight, the weight vibrates at the same frequency (or so) as the table, on top of the piezo element, inducing substantial pressure changes that can be easily detected.



You can experiment with more or less weight and look at the graph and how differently it behaves.



The Code



int inputPin = A1;




void setup() {


 // put your setup code here, to run once:


 pinMode(inputPin,INPUT);


 Serial.begin(9600);


}




void loop() {


 // put your main code here, to run repeatedly:


 Serial.println(analogRead(inputPin));


}













WiFi Scanner using PCD8544 and NodeMCU




While searching in my Pandora’s Box of electronics, I came across the beautiful PCD8544, or the more familiar name, the Nokia 5110 LCD.
 [image: pcd8544]



This amazing piece of hardware is fully programmable using Arduino and ESP8266/NodeMCU. Thanks to
 


 Adafruit and
 


 bbx10 (Github user) for their libraries which make our lives easier. The display has a resolution of 8448 pixels. Each pixel can only be on or off, so there you have it, a monochrome display.



In this tutorial we are going to scan for WiFi networks, display their SSID, MAC Address (BSSID), the encryption type and the signal strength (RSSI);




The Parts




●
 
 NodeMCU or ESP8266 with certain pins exposed.



●
 
 PCD8544 Nokia 5110 LCD



●
 
 8 jumper wires



●
 
 5 resistors at 1k Ohm or so (these may not be needed since the ESP8266 pin voltage level is 3.3v, but better be safe)



●
 
 1 220 Ohm resistor for LED (this is important)



I am using 2 small breadboards but obviously you can use a big one or even solder everything on a veroboard.




The Wiring








●
 
 LCD Pin
 NodeMCU



●
 
 RST
 D2 (resistor in series)



●
 
 CE
 D1 (resistor in series)



●
 
 DC
 D6 (resistor in series)



●
 
 DIN
 D7 (resistor in series)



●
 
 CLK
 D5 (resistor in series)



●
 
 VCC
 3.3v



●
 
 Light
 either 3.3v or GND depends on the board. (220 Ohm resistor)



●
 
 GND
 GND



Please make sure you connect VCC to 3.3v. The LCD is
 NOT
 5V tolerant




The Code




#include "ESP8266WiFi.h"


#include <Arduino.h>


#include <SPI.h>


//https://github.com/adafruit/Adafruit-GFX-Library


#include <Adafruit_GFX.h>


#include <Adafruit_PCD8544.h>


//https://github.com/bbx10/Adafruit-PCD8544-Nokia-5110-LCD-library/tree/esp8266




Adafruit_PCD8544 display = Adafruit_PCD8544(14, 13, 12, 5, 4);




void setup() {


Serial.begin(115200);




WiFi.mode(WIFI_STA);


WiFi.disconnect();


delay(100);




Serial.println("WiFi Scanner using Adafruit PCD8544 and GFX libraries");




display.begin();


display.setContrast(40);


//adjust for your display (if you see a black screen try lowering the value, if all white try increasing it. Max 127)




display.clearDisplay();


delay(2000);




display.clearDisplay();


display.setTextSize(0);


display.setTextColor(BLACK);


display.setCursor(0,0);


display.println("Runtime");


display.setCursor(0,10);


display.println("Projects");




display.setCursor(0,20);


display.println("WiFi Scanner");




display.display();


delay(2000);


Serial.println("Setup done");


}




void loop() {


Serial.println("Scan started");




display.clearDisplay();


display.setTextSize(1);


display.setTextColor(BLACK);


display.setCursor(0,0);


display.println("Scan started");


display.display();




int networksFound = WiFi.scanNetworks();


Serial.println("Scan Complete");


display.setCursor(0,10);


display.println("Scan Complete");


display.display();


delay(2000);




if (networksFound == 0){


Serial.println("No Networks Found");


display.clearDisplay();


display.setCursor(0,0);


display.println("No Networks");


display.setCursor(0,10);


display.println("Found");


display.display();


}


else


{


Serial.print("Displaying ");


Serial.print(networksFound);


Serial.println(" networks");




display.print("Displaying ");


display.print(networksFound);


display.println(" networks");


display.display();


delay(2000);


display.clearDisplay();


display.setCursor(0,0);


display.print("Displaying ");


display.println(networksFound);


display.setCursor(0,10);


display.println("Networks");


display.display();




for (int i = 0; i < networksFound; ++i)


{


// Print SSID and RSSI for each network found


Serial.print(i + 1);


Serial.print(": ");


Serial.print(WiFi.SSID(i));


Serial.print(" [");


Serial.print(WiFi.BSSIDstr(i));


Serial.print(" ]");


Serial.print(" (");


Serial.print(WiFi.RSSI(i));


Serial.print(")");


Serial.println(getEncryptionType(WiFi.encryptionType(i)));




display.clearDisplay();


display.setCursor(0,0);


display.print("Network: ");


display.println(i);


display.setCursor(0,8);


display.print("SSID: ");


display.println(WiFi.SSID(i));




display.print("MAC: ");


display.println(WiFi.BSSIDstr(i));




display.print("RSSI: ");


display.println(WiFi.RSSI(i));




display.print("ENC: ");


display.println(getEncryptionType(WiFi.encryptionType(i)));


display.display();




delay(5000);


}


}




}




char* getEncryptionType(int enc) {


switch(enc){


case ENC_TYPE_NONE: return "Open";


case ENC_TYPE_WEP:


return "WEP";


case ENC_TYPE_TKIP:


return "WPA";


case ENC_TYPE_CCMP:


return "WPA2";


case ENC_TYPE_AUTO:


return "WPA/WPA2";


}


}







Conclusion




In this tutorial we are only using a very small portion of functions provided by the libraries. Primarily:



●
 
 display.print() which print text to the screen



●
 
 display.clearDisplay() which clears the screen



●
 
 display.setCursor() which sets the cursor to a position on the display



●
 
 and most importantly… display.display













 
Artificial Intelligence on Arduino - An invincible Tic Tac Toe Player




It is hard to imagine an Arduino with only 2k RAM capable of playing tic tac toe better than most of us. That is right, an unbeatable Tic Tac Toe player with a memory footprint of less than 2 kilobytes. In this tutorial we will implement a perfect Tic Tac Toe player which will never lose, it can only win or draw.



In such simple games, where the amount of possible moves is limited and respectively small, the minimax algorithm comes very handy. The minimax algorithm works best when the end of the game can be predicted. A board game such as tic tac toe is relatively simple with only 9 steps. So the decision tree off all possible moves needs to have a depth of only 9 levels. That said, the total permutations amount to 9! (Factorial) which is 362,880 although there are many games that end before the grid is filled up so that number is actually much less.



So, we at Runtime Projects decided to have a go with this by creating an invincible Tic Tac Toe player. The game will be outputted using the serial port so as not to complicate matters. However feel free to use this code to create your own version with LCDs or LEDs. We are not going into the details of implementing the algorithm here. This is pure C programming with a little thought about keeping a very small memory footprint. To make the game a little interesting, we have assigned a difficulty level for the AI to give us humans, a chance to win. The difficulty level is set from 1 to 8. 1 being the easiest and 8 being impossible. First the user is asked to state that is starting the game. Then, placing the X’s is simply entering the number of the box from 0 to 8.



Download the code from
 


 
https://github.com/klauscam/ArduinoTicTacToe










Thank you for Reading



I hope this e-book helped you a great deal in understanding the Arduino world. We expect you to build awesome projects from what you have learnt here. It would be a pleasure to share your projects on our website. So please visit
 
http://runtimeprojects.com

 for more projects, tutorials and latest source code updates. We also have a contact page at
 
http://runtimeprojects.com/contact-us/

 , feel to drop us a comment there.



Thanks again. And happy building
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